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1. Introduction 
This Release Content Description provides information about new or changed functionality that will be 
available in Outpost Packet Message Manager Release 2.4.  This information is organized under the 
following sections: 
! New Features:  A new capability that did not exist in any prior version of Outpost in any form. 
! Enhancements:  A change to an existing feature that further improves the performance or usability of 

the application.  Enhancements include minor changes, internal changes (that may not be evident to the 
user, but contribute to improved supportability increased stability, or application performance) and bug 
fixes. 

! Changes since Version 2.3:  A list of the various changes that were introduced in maintenance or 
defect releases since the original v2.3 release. 

2. New Features  

2.1. ER#508: Address Book Support 
Since Winlink support was added to Outpost (Feb 2007), the logical (and most requested) new feature was 
an address book.  This became evident as Outpost users took advantage of Winlink’s ability to send a single 
message to multiple users as addressed in the TO: field. 
The Outpost address book will start with some basics: 
1. An address book entry is an alias for one or more user’s real AX25 or SMTP addresses.   
2. Single User.  A user name is mapped to an AX.25 or SMTP address.  For instance, 

a. Address entry = “JIMO” is mapped to AX.25 address “KN6PE” 
b. Address entry = “JIMATHOME” is mapped to SMTP address “kn6pe@arrl.net” 

3. Distribution Lists.  This is where I anticipate a lot if benefit for Outpost users, particularly for Winlink 
users.  A Distribution list of CARES_AECS could reference a series of AX.25 or SMTP email 
addresses.   

4. The user will be able to enter an address book entry into a messages’ TO: field either by typing it 
directly.  The “+” sign ahead of the name (“+jimo”) will indicate that this is an address book entry.  
Error checking will occur to ensure the “+entry” really exists prior to processing the Send command 
for the message form.  

5. Outpost will manage the replacement of the address book entry with the correct list of addresses at the 
send/receive time.  If the BBS is a Winlink RMS or CMS node, Outpost will add the “SMTP:” prefix 
to all SMTP addresses if the “SMTP:” prefix is not there.   

6. At the EMCOMMWEST’09 session in Reno NV this May, users also expressed interest in using 
distribution lists for standard AX.25 PBBS and BBSs.  Since distribution lists are not supported on 
most BBSs other than Winlink, Outpost will optionally parse the distribution list and send a message to 
each entry: for instance, a 5-address distribution list will result in 5 distinct messages being sent.  This 
should be used sparingly and considered as a last-resort alternative to just sending a Bulletin message. 

7. Outpost Address Book entries can be forwarded to other Outpost users or posted as a Bulletin.  On 
retrieving the message, the recipient has the option of adding the address to his/her local Outpost 
address book. 
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2.2. ER#659: ICS213 support 
Thanks to everyone who replied to my inquiry on ICS213 forms and their use.  Based on the feedback, 
v2.4.0 will include a first release of a basic ICS-213 facsimile.  Highlights of this implementation are: 
1. Standard ICS-213 form.  This implementation will be based on a standard ICS213 form as generally 

used by our served agencies (http://training.fema.gov/EMIWeb/IS/ICSResource/assets/ics213.pdf). 
2. The data entry form will be implemented as a separate program (ics213mm.exe) that can reside either 

on the same PC with Outpost or on a remote PC on the same LAN as Outpost.   
3. The program has the following features: 

a. Default field entries can be set up to accommodate commonly used fields (From, Position, To, 
Position).  Additionally, the date/time will automatically be entered. 

b. Local message management, includes save a local copy of all messages, save messages in 
progress, send completed messages, delete messages no longer needed, browse the list of 
messages maintained locally, or start with an existing message to create a new one. 

c. Print the message in a standard ICS213 look and feel format. 
4. The ICS213 message sent to Outpost will be in an ASCII-formatted message format.  This will allow 

the message to be sent to and read by non-Outpost programs if they exist on the network. 
5. Once Outpost receives a message from ics213mm.exe, the Outpost standard message form will open 

and the Packet Operator can review and fill in the TO: packet address destination and then press 
SEND. 

6. At the receiving Outpost station, the ICS213 program will poll Outpost for any incoming ICS213 
messages; Outpost will deliver a local copy to the ICS213 program. 

7. The ICS213 program supports the ability to create a reply and send it back to the originator. 
8. If more than one ICS213 program is used throughout the LAN environment, then the ICS213 user 

must define an 8 character “ID” to ensure the correct reply message routing back to the message 
originator. 

Again, this will be the first release of this capability.  Feedback and comments are welcome. 

3. Enhancements 

3.1. BBS SUPPORT 
The following BBSs will now be supported by Outpost: 
1. ER#576: MFJ-1274 PBBS   
2. ER#592: OpenBCM BBS.  This BBS is popular in Europe and has a following on the U.S. East 

coast.  
3. ER#744: PK-96  PBBS  
4. ER#777: BPQMailChat BBS.   This is a new BBS currently in BETA release.  
5. ER#787: Add support for BBS KFJ-127x version MFJ-2.0 firmware. 

3.2. Message Handling 
ER#656: Add control to manage on-line report and message printing.  The request dealt with the 
standard message BBS, FROM, TO, Subj headers that sit on top of the body of the message.  Outpost 
now supports a “File > Print, no Headers” option that will only print the message body.  Additionally, 
because of the auto-printing capability that can occur from the Send/Receive Session, an “AutoPrint 
with Message Headers” check-box is now available from Tools > Send/Receive Settings, 4th tab 
(default = CHECKED). 
 
ER#684: Extend TO: address field size.   This change extends the TO: field from 256 to 1024 
characters, thereby allowing more destination entries to be entered. 
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ER#729: Automatically open ARL message maker when clicking on selecting ARL on NTS form.   
 
ER#757: Message buttons hidden when screen is sized too small.   This is a program-wide clean-up 
item that tightens up the grouping of Outpost short-cut buttons that are located on the top of each form. 

 
ER#761: Opdirect/PacForms: removed index page link.   After pressing Send to Outpost from the 
PacForms, Opdirect would send back a message stating that the message was received, and offer the 
link to get back to the PacForms list.  This did not work with all browsers.  This change removes the 
link and the PacFORMS will direct the user to use the Browser’s Back button to return to the form just 
submitted. 
 
ER#771: Add on-line reports feature to set up the TO: field with a <to> tag.   This change adds a 
new on-line report tag that lets the user declare the destination TO: address from the on-line report 
template. 
 
ER#781: Suppress the Opdirect popup when a message is created and queued with OpDirect - it 
pops up asking if it should be displayed in an html page.  
 

3.3. Send/Receive Handling 
ER#619: Add node handling for KPC4 to support the "Xconnect" command.  Some KA-Nodes 
use the “X” command instead of the “C” command to connect to the other port.  For node 
configuration, Outpost will now include a connect command field that defaults to “Connect”.  The user 
now has the option of changing this parameter and entering an “X” to cross-band connect. 
 
ER#747: Consolidate same level notifications into a common window.  Even I found this annoying.  
While the intent was to let Send/Receive error messages persist beyond the session with the BBS, these 
windows can build up if you leave Outpost running overnight or even longer when you have a problem 
with a BBS.  This change now writes all notifications to a single window that can be scrolled to see 
what errors occurred.  Additionally, this window can now be resized to view more of the posted 
notification messages. 
 
ER#783: Skip SNOS messages when the Status contains "K" for killed.  This is to accommodate a 
delayed housekeeping process that ultimately removes the message from the list. 
 
ER#784: Check KPC3 PBBS message date-time for invalid date.  For whatever reason, Kantronics 
lets the date time be set to 000000000000, that then shows up as a message timestamp of 00/00/00, a 
time that Outpost does not like.  If Outpost finds one of these cases, it will now write this message with 
a date of 01/01/1980 with notification.  This change forces the date to the beginning of time 
(01/01/1980) as a flag that there is a date problem on the BBS. 

3.4. Setups and Configurations 
ER#628: Add BBS/TNC “Recently Used” Access.  Most BBSs are accessed with a specific TNC.  
While ER#776 creates a link between a BBS and a TNC device, this enhancement causes Outpost to 
write a BBS | TNC entry into a Recently Used list off of the Outpost main page, File Menu.  Now, 
users can pick the one of many recently accessed BBS/TNC combination with fewer key strokes. 
 
ER#677: Add Friendly name for BBS configuration.  There are times when there are variations to 
the BBS configuration that you may need make, particularly with designating the path.  This requires 
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the user to go back into the BBS configuration, make the change, and then proceed with their 
operation.  This change adds a friendly name in addition to the connect name for all BBS 
configurations.  For instance, you could have a BBS named “K6FB-DIRECT” and “K6FB-AGWPE”, 
each connecting to K6FB-2 but with different path setups. 
 
ER#695: Extend BBS Digipeat field size.  When configuring digipeaters, the BBS Digi field was too 
small.  This field size has been expanded to 128 characters and should be more than enough for the 
more daring digi-hopping users (the typical limit imposed by most TNCs is 8). 
 
ER#763: Correctly implement Winlink password handling; removes workaround.   This resolved 
2 workarounds that were needed to address users accessing Winlink CMS.   
(i) Telnet Transparency.  There is now a new check-box to indicate whether this telnet port is 
accessible with the Transparency option.  Outpost users do not need to put the “.” in front of their call 
from now on. 
(ii) Resolves Outpost’s short telnet password field and a very long Winlink password. 
 
ER#764: Add clone BBS config as a BBS Setup option.  With the introduction of BBS Friendly 
names, this option allows you to create a copy of a BBS configuration, then modify it accordingly, 
thereby avoiding the need to re-enter the entire configuration from scratch. 
 
ER#765: Add clone TNC config as a BBS Setup option.  Similar to the BBS Clone config change, 
this option allows you to create a copy of a TNC configuration, then modify it accordingly, thereby 
avoiding the need to re-enter the entire configuration from scratch. 
 
ER#776: Create a link for a BBS to its TNC/Device.  This change lets you create an association 
between the BBS and the TNC.  Now, if a TNC/Device was previously identified with a particular 
BBS, when you choose the BBS, its associated TNC/Device automatically will be set up as well. 
 
ER#778.  Removes the option to hide/display “Save w/o Headers”.  This essentially removes the 
option to turn on and off Save without Headers.  This option is now permanently on.  The value of this 
is to address report messages that come in that do not need to clutter of the message header. 
 
ER#788.  Add Station ID check-box to show at startup; sets focus on OK.  After setting the Station 
Identification, you can uncheck this box directly on this form to prevent it from popping up again on 
startup.  This is the same control as found on the Tools > General Settings menu. 
 
ER#795: Change Signature error handling to be the same as all the others.  Now, any missing field 
will be highlighted instead of the message box popup. 

3.5. Scripting Changes 
ER#748: Startup script automation. 
ER#751: Kick off specific script from Outpost main. 
These two changes were inevitable.  Outpost now supports some additional script automation features:  
 (i)   On Outpost Startup or Exit, run a previously identified script. 
 (ii)  From Outpost, select the script to run, and kick off Outpost Scripting with this script. 
 (iii) New “Exit” script command that will terminate scripting when encountered.  Supports 
        one-time script execution when you really want scripting to exit. 
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ER#758: Assign Mycall to current Outpost Mycall if Opscript Mycall is blank.   This change is a 
user efficiency change. 
 
ER#782:  Allow user to point Send/Receive button to a script.  This change lets the user choose 
between the native Outpost Send/Receive process and a user defined script. 

3.6. Other 
ER#785: Change Outpost WindowState to always start up as Normal.  This change ensures that if 
Outpost is minimized and off’ed, when restarting, it comes up in its last known geometries. 

3.7. Resolved Problems 
ER#622: FROM:  field is too short for some SMTP addresses.  This change extends the FROM: field 

so that this situation does not come up. 
ER#737: Resolves ipserial.exe echo on/off control.   This was a nice-to-have, and never really worked.  

Echo On/Off is now disabled, and Echo ON is the default state.  This change lines up with 
how Outpost uses Echo On/Off.  

ER#755: Fix Drag-and-Drop problem.   This fix changes some of the logic to better deal with 
situations after dragging messages from one folder to another. 

ER#756: Known KPC-2 PBBSs.   The KPC2 has 2 firmware revisions (KPC2-5.0-HM$ and KPC2-
3.06-H) that do not behave the same.  This change correctly differentiates between the two. 

ER#759: Fixes the problem when telnet password is blank.   This problem is resolved. 
ER#760: Fixes the problem with SP, ST, and SB commands.   After all these years, someone actually 

tried to change the Send Private, Send Traffic, and Send Bulletin commands in the BBS setup, 
and the changes did not keep.  This problem is resolved. 

ER#774: Fixes WriteFile command that failed with Windows98, and not XP.  
ER#779: Resolves situation where the Directory Select option (Tools > Directory Settings) did not 

pick up and apply the Drive the directory list. 
ER#780: Fixes the problem where the Report form closes without confirming that the report file 

actually exists. 
ER#789: Fixes the TNC Setup Apply Button; it did not get the form back to an initial state. 
ER#790: Fixes the BBS Setup Apply Button; it did not get the form back to an initial state. 
ER#791: Resolves situation where a user could type into any of the Comm Port settings instead of 

using the pull-down.  Now, users now cannot make manual entries. 
ER#792: Fixes the problem where, if Digipeat option was selected but no digis are loaded, it was 

accepted.  Additional validation checks are now in place. 
ER#794: Fixes the problem where, if the Default Destination option was checked and its field was left 

blank, no error was reported.  Additional validation checks are now in place. 
ER#796: Resolves the situation where the NTS Message Maker was not replacing the last period of the 

message with the “X”. 
ER#797: Resolves the situation where NTS was clearing the default destination setting if “Send NTS 

as Private” was set. 
 

4. Documentation 
1. The Outpost user guide will be updated to reflect the current state of Outpost. 
2. The Outpost Scripting users guide will be updated to reflect the current state of the Outpost 

Scripting program. 
3. HOW-TOs on the Outpost website will be updated to capture changes incorporated here 
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5. Changes since v2.3 c021 
ER#733: When no comm ports on the system, get Error 380.  
 
ER#735: Resolved Outpost recognizing AEA-232M when connecting locally with an 
MDCHECK. 
 
ER#740: KPC3 BBS Busy was still not working.  This problem is resolved in 230c024 
 
ER#745: Telnet connect error shows up as s pop-up box, not a Notification.  This was a problem 
since it blocked scripting from progressing.  Rewrote all pop-up boxes into notifications. 
 
ER#754: Resolved AGWPE Problem where AGWPE was erroring out. 
 
ER#750: Resolved JNOS date problem when the BBS is not operating in GMT or UTC time.  This 
problem is resolved in 230c030. 
 
ER#772: Resolved JNOS Telnet access problem where JNOS was not detecting the end of message 
command.  This problem is resolved in 230c030. 

. 
ER#774: Defect: Script WriteFile command errors on Windows98.   This problem occurred on 
Windows 98, but not on XP.  This problem is resolved in 230c031. 
 
ER#775: Defect: Subject Lines with DateTime format errored.   This was truly a corner case when 
the User selected the DateTime subject Line identifier format AND the message was created from a 
script.  This problem is resolved in 230c031. 
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